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Preface 
 
Welcome to the Oracle Insurance Insbridge Rating and Underwriting RateManager Administrator User 
Guide. This guide describes the features and functionality of the Oracle Insurance Insbridge Rating and 
Underwriting RateManager (RateManager) Tools Menu. RateManager is a component within the Oracle 
Insurance Insbridge Rating and Underwriting (IBRU) System that enables users to manage the product 
definition and modification process, including rating and underwriting logic. The Tools Menu is where the 
majority of RateManager Administrator functions are performed. References to the RateManager User 
Guide, which covers the Modules Menu, will be made periodically.  
 

AUDIENCE 
 
This guide is intended for RateManager system administrators who are tasked with managing system 
features. Users should be familiar with their company’s practices and terminology. Advanced users may 
benefit from having knowledge of their company’s current working rate manual. 
 

RELATED DOCUMENTS 
 
For more information, refer to the following Oracle resources: 
 

● The Oracle Insurance Insbridge Rating and Underwriting Framework Administrator User Guide. 
 

● The Oracle Insurance Insbridge Rating and Underwriting SoftRater Server User Guide. 
 

 
● You can view these and other IBRU guides on-line at this address: 

 
 

http://www.oracle.com/technology/documentation/insurance.html 
 

CONVENTIONS 
 
The following text conventions are used in this document: 
 

Convention Description 

bold Boldface type indicates graphical user interface elements associated with an 
action. 

Italic Italic type indicates book titles, emphasis, or placeholder variables for which you 
supply particular values. 

Monospace Monospace type indicates commands within a paragraph, URLs, code in 
examples, text that appears on the screen, or text that you enter. 
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Preface 

SYSTEM REQUIREMENTS 
 
For minimum operating system and hardware requirements, please see the Hardware Software 
requirements guide. 
 

Manual History 
 
New editions incorporate any updates issued since the previous edition.  
 

Edition Publication 
Number 

Product 
Version Publication Date Comment 

1st Edition P01-775-01 R 4.0 May 2010 New Release Update 
2nd Edition P01-775-02 R 4.0.1 August 2010 Updated Release 
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Chapter 1 

SYSTEM OVERVIEW 
 
Prior to accessing RateManager, you should have received: 
 

● RateManager URL – RateManager can be accessed by going to http://<yourserver>/rm, where 
<yourserver> is the name of the server where RateManager is installed. 

● Username – usernames are required.  
● Password – passwords are required. 
● Subscriber – subscriber information may not be required. 

 
 A subscriber may be a single carrier or a subscriber may be an individual group within the company. If 
more than one subscriber has been set up by the system administrator, you will have to select the 
subscriber where you want to work. If only a one subscriber has been setup, you will not have to select a 
subscriber. 
 
If you do not know any of this information, please contact your system administrator. 
 

If multiple subscribers have been setup, there will 
be a menu for users to select the subscriber they 
will work under. 

A single subscriber will only have username and 
password fields. Subscriber information will not be 
required. 

 
Logging In 
 
Access to RateManager is gained through a login screen. To login, enter your username and password 
and click LOGIN. Depending on your company setup, you may need to select your subscriber. If a 
company subscriber is required, a menu will be displayed. Select the subscriber you need, and continue 
to log in. 
 
A successful login will place you on your Home Tab. 
 
A failed login will display an error message. Please correct any errors and try again. If you cannot log in, 
please contact your system administrator. 
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Chapter 1 – System Overview 

Help Logging In 
 
If you have forgotten your password, username or need assistance with logging into the system, please 
contact your system administrator. 
 
 
Rights 
 
RateManger uses rights to allow users access to various areas. The type of rights you have will determine 
what you can view, edit, add or delete. There are three types of rights:  
 

● No Access –you cannot enter this area. The fields will be grayed out or not displayed. 
● Read Only – you can view the information but you cannot make any changes. Save, edit or other 

features may be listed on the toolbars or right click menus, but you will not be able to effect any 
changes. 

● Full Access – you can view, edit, add or delete information where applicable. 
 
The system administrator sets group rights. If there is an area you cannot enter or edit, and you think you 
need access, please contact your System Administrator. 
 
 
Logging Out 
 
Logging out will remove you from RateManager. 
 

 
Figure 1 Logging Out  
 
To log out, click File Logout. If you have any elements open that show a change, you will be asked if 
you want to save. After saving your work, you will be logged out. 
 
 

RATEMANAGER TABS AND MENUS 
 
In RateManager Release 4.0, multiple tabs can be utlized. The tabbed authoring interface allows for 
multiple activities to be open across separate tabs without losing any functionality. Each tab functions 
independently. You can view the Program Explorer, then edit a program version, and then create a new 
algorithm without being forced to close the prior tab. 
 
The RateManager tabs follows a familiar model, a fixed top bar menu with four options. Each option 
contains a menu of system features. Each feature will open either a new tab or a popup window. The new 
menus contain the same features that were in previous releases of RateManager. 
 

10 



Chapter 1 – System Overview 

 
 
The File menu: 
 

  Reload – reloads the page. Use this option when you want to refresh the screen. 
 

  Logout – logs you out of the system. 
 
 

 
 
 
The Module menu: 
 

  Program Explorer – the program explorer holds sublines, folder, programs and program 
versions. Many of the procedures and functions performed under the line of business are found 
here. 

 
  Testing – opens the testing module. This area allows you to test your rating program during 

development without loading packages. In previous releases, this area was called 
ScenarioManager. 

 
  Impact Analysis – opens the area for batching and data analysis. This area is a combination of 

previous release BatchManager and PricingManager modules. 
 

  Releases – allows groups of rating packages to be automatically deployed and loaded to IBFA 
through a release. If you do not have release rights, this option will not be displayed. Please see 
the RateManager Tools User Guide for more information. 

 
  Workflows – A collection of programs from all lines of business combined with output mappings 

and assigned to execute in sequence that returns a single or multiple results. In previous 
releases, this area was called Universals.  

 
  Library – the library is where templates are stored and managed.  
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Chapter 1 – System Overview 

 
 
 
The Tools menu: 
 

  Manage Lines – opens a screen where administrators can manage lines of business. This is an 
advanced system feature and may not be available to all users. 

 
  Audit – contains the audit logs of system users.  In previous releases, this area was called Logs. 

This is an advanced system feature and may not be available to all users. 
 

  Import Programs – is where programs are imported. This is an advanced system feature and 
may not be available to all users. 

 
  Security – is where users, user groups and sessions are managed. This is an advanced system 

feature and may not be available to all users. 
 

  Database – this area is for administrators to create backups and deploy updates. This is an 
advanced system feature and may not be available to all users. 

 
  Preferences – brings up the window where you can select the snaps you want to display on your 

Home Tab. For advanced system users, system setup information will be displayed. 
 

  Change Password – allows users to change their password. 
 

 
 
The Help menu: 
 

  RateManager Help – clicking this option will bring up online help. 
 

  RateManager Version – clicking this option will bring up system information. In previous 
releases, this area was called Versions. 
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Tab Navigation 
 
Multiple tabs can be open at any time. You can move from tab to tab by clicking the tab you want. You 
also can click the tab display icon  in the upper right hand of the screen to see a list of all the open 
tabs. You can navigate to any tab in the list by selecting it. 
 

 
 
 
NOTE: If you have a popup window open, you will have to close the popup before you can click on 

another tab. 
 

 - The close tab icon will close the tab you are currently on. If you have any elements open that show a 
change, you will be asked if you want to save. 

 

Home Tab 
 
Once you have logged in, you will be on your Home Tab. The Home tab has a control panel that contains 
links to all the major components of RateManager. Additional panels called Snaps also can be added. 
Snaps are modules that contain information or links to elements that you recently worked on. For 
example, if you selected the snap My Recently Opened Programs, you would see a list of the last 10 
programs that you opened. 
 
The Home tab can be customized to contain the information you want to see immediately when you log 
in. The Home tab will always be the first tab and cannot be closed. 
 
The Control Panel contains links to all the major components found in the Modules menu. This area 
cannot be removed but can be reduced by clicking the arrow in the upper right hand corner of the panel. 
The Tools menu does not have a link in the Control Panel. 
 
The RateManager home page displays the current username, subscriber and version at the top of the 
screen. 
 
Access to the pages you are authorized to view or change is gained by selecting the area you want from 
the menu bar or clicking the icon on the Control Panel. Under the Program Explorer, each line of business 
where you have access is displayed. If you have been granted edit privileges, you can add or change 
information. 
 
For more on the Home Tab, please see RateManager Modules User Guide. 
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Chapter 2 

MANAGE LINES 
 
The Manage Lines of Business (LOB) screen gives you a snapshot of all the lines of business currently in 
the system and shows if the line is activated or deactivated. RateManager comes with 29 system lines. 
 
Lines of business should be setup prior to creating non-admin users. If you create regular users without 
any lines being activated in the system, you will have to return to the Group Management screen to 
assign permissions. 
 
NOTE:  The Manage LOB screen is available to system administrators only. If you do not have this role, 

you will not be able to perform these actions. 
 
 
Navigating to the Line of Business Screen 
 

1. From the menu tree, expand Tools and select Manage Lines.  
 

 
 

2. This will display the Manage LOB screen. 
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Chapter 2 – Manage Lines 

 
Figure 2 Manage LOB Screen 
 
 
Manage LOB Menu Bar 
 
The menu bar at the top of the screen allows you to: 
 

  New starts the process of creating a new line of business.  See Creating New Lines of 
Business for more information. 

 
  Edits the currently selected line of business.  

 
Show listing for lines: Allows you to view LOBs by activation status. Select the status you want 
to view from the drop down menu.  
 

- ALL – Selecting ALL will display all of the lines currently in the system. 
- Activated – Selecting activated will display only the currently activated lines. 
- Deactivated – Selecting deactivated will display only the deactivated lines 

 
All is the default selection. If you choose another selection, the screen will refresh with your 
choice.  
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Manage LOB Fields 
 
Lines are listed by ID number. The total number of lines in the system, both activated and deactivated, is 
displayed on the bottom of the screen. 
 

ID:  The unique identifier assigned to each line of business. Once assigned, these numbers 
cannot be changed. 

 
Description:  The name of the line of business.  

 
Activated:  A check in this column indicates that the line of business has been activated and is 
ready for use. 

 
Type:  Shows whether the line is:  

 
● System built. System built lines of business are the standard lines that were included in 

the original download of the system. System lines cannot be deleted. 
 
● Custom built. Custom built lines of business are lines that were added later. Custom line 

can be deleted. 
 
 
Manage LOB Functionality 
 
The Manage Line of Business screen allows you to do the following: 
 

● Create a New Line of Business 
● Edit a Line of Business 
● Activate a Line of Business  
● Deactivate a Line of Business 
● Remove All Programs from a Line of Business 
● Delete Custom Lines of Business 

 
NOTE:  System lines of business cannot be deleted. If there is a System line of business you no longer 

need, you can deactivate it. This will stop the line from being listed and being available. Custom 
lines can be deleted. 
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Chapter 2 – Manage Lines 

Creating a New Line of Business 
 
Custom lines may be added at any time by a RateManager administrator. LOB ID numbers are entered 
manually. This allows you to match any LOB that may be Custom from the Library. LOB ID numbers must 
fall between 100-250. 
 
 
To Create a New Line of Business 
 

1. Navigate to the Line of Business screen. 
 

2. Click New. A New Line of Business popup will be displayed. 
 

 
Figure 3 Entering a New Line of Business 
 

3. In the new line of business popup, enter an ID number. The number must be an unused number 
between 100 – 250. If the number is out of range or being used, you will receive an error 
message. This number cannot be changed after you save. 
 

4. Enter a name. The name may consist of up to 50 characters.  
 

5. If needed, enter a date mask. This date format will be used as the default for all programs 
created within that line of business. 
 

6. By clicking the Activated checkbox, the line of business will be activated after saving. 
 

7. Click Save. The line of business, if activated, should show in the Program Explorer Program 
Folders navigation bar. If it does not appear, click the “Sync Menu” button in the upper portion of 
the navigation bar.  
 

8. Next, you will need to navigate to Tools Administration Group Management to set 
permissions. This will allow groups access to view or edit variables, algorithms and other program 
options. 
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Chapter 2 – Manage Lines 

 
Figure 4 Setting Security for New Lines of Businesses 
 
9. All groups except Administrators will be denied access to any new line of business. You must allow 

the group access before any program options will be available to them. Select the group that will need 
access to the new line of business.  

 
10. Click on Rights. A Group Rights screen will be displayed. Expand out the new line of business.  
 
11. Place a check in all the boxes where the group will require access. Click Save. Users in that group 

will now be able to view and use the selected options. For more on user groups and rights, see Group 
Management.   

 
 
NOTE:  Adding a line to group permissions needs to be done for a first time activation only. If you 

deactivate and then activate again, you will not need to reset permissions. 
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Editing a Line of Business 
 
Any line of business may be edited at any time.  
 

1. Navigate to the Line of Business that you want to edit. 
 

 
Figure 5 Selecting a LOB to Edit 

 
2. You can double-click the line of business you want to edit or select it and click Edit. You also can 

right click and select Edit from the menu. The Edit LOB popup box will open, allowing you to edit 
the line of business.  

 

 
Figure 6 Editing an LOB 

 
3. Make any necessary changes. The Name, Date Mask and Activation status can all be edited.  

 
4. When you are finished, click Save. The line of business will refresh with the changes you made. 

Click Close to go back to the Manage LOB screen without saving any changes.  
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Activating and Deactivating a Line of Business 
 
Any line of business may be activated or deactivated at any time. Activating a line of business will display 
the line and all associated programs on the Program Explorer Program Folders navigation bar. 
Deactivating a line of business will remove the line and all associated programs from the Program 
Explorer Program Folders navigation bar. 
 
You can activate and deactivate a line as many times as you need. Permissions and contents are not 
removed when a line is deactivated. If you reactivate, the permissions and contents will be the same. 
 

1. Navigate to the Line of Business that you want to activate or deactivate. 
 

2. Right click to get the menu. For a System line, a deactivated line will have two right click menu 
options; an activated line will have three menu options. For a Custom line, a deactivated line will 
have three right click menu options; an activated line will have four menu options. 

 

 
Figure 7 Selecting a LOB to Activate 

 
3. To activate: Click Activate. The screen will refresh and the line of business that you activated will 

now be displayed on the Program Explorer Program Folders navigation bar. You also can 
activate a line of business by entering the edit screen and selecting Activated. 
 

 
Figure 8 Selecting a LOB to Deactivate 

 
4. To deactivate: Click Deactivate. The screen will refresh and the line of business that you 

deactivated will not be displayed on the Program Explorer Program Folders navigation bar. 
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Removing All Programs from Line of Business 
 
Any line of business can have all programs removed. Proceed with care, this action cannot be undone 
and will remove all programs under that line. The sublines will remain in place and all globals under each 
subline will remain. If you are unsure, you can deactivate a line of business. This will remove the 
programs from usage but not from the system.  
 

1. Navigate to the Line of Business where you want to remove all programs. 
 

2. Right click to get the menu. 
 

3. Click Remove All Programs. A warning message will be displayed. Click Yes to remove all 
programs. Click No to cancel the action. 

 

 
Figure 9 Removing All Programs from an LOB 

Deleting a Custom Line 
 
Custom lines can be deleted at any time. All associated contents for the line will be deleted as well. 
Please verify this is the action you want to take. This action cannot be undone. Two warnings will be 
given. You will need to refresh the screen to see that the line has been deleted. 
 

1. Navigate to the custom Line of Business you want to remove. 
 

2. Right click to get the menu. 
 

3. Click Delete. A warning message will be displayed. Click OK to remove the line. Click Cancel to 
cancel the action. A second warning message will be displayed. Click OK to remove the line.  

 

 
Figure 10 Removing All Programs from an LOB 
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AUDIT 
 
RateManager can keep an audit log of user activity. Audit logs contain information such as action 
performed, user ID, date and time stamp. Audits set to high will also track adding a user, editing a user 
and deleting a user. Audit logs also can include program information such as program ID, program 
version and line of business as well as element information. 
 
The Audit tab contains a list of audits logs. The audit log feature has to be enabled at the group level. On 
the Group Management tab, Administration Security Group Management, select the group where you 
want to apply auditing. There are three options for auditing the group:  
 

● None – no auditing will be done. 
● Normal – all saves and deletes will be tracked. 
● High – all new, creates, changes, saves and deletes for the group will be logged. 

 
If the group(s) has high auditing, more audit logs will be created and you will have more types of actions 
you can filter on. 
 

 
Figure 11 Audit Tab 
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Navigating to Audit  
 

1. Select Tools Audit. 
 

2. This will open the Audit tab. 

FUNCTIONALITY 
 
The Menu Bar is located at the top of the tab. The menu bar contains the functions you can perform on 
this tab. 
 
 
Functions: 
 

 

Filter:  Opens up the filter option. You can select fields to filter on. The entries you 
make in the filter option will be the results returned. The results will be displayed in the 
main body of the tab. Any field that does not match will not be displayed. Filters are 
removed when you exit the tab or re-enter the filter option and remove the filter. 

 
Audit Report: Opens up a full Audit Report for the audits currently being displayed. 
Audits that have been filtered out will not be displayed. 

 

Purge All: Purges all audits currently displayed. Results can be filtered for purging. If 
you filter audits, only the audits that meet the filter criteria will be displayed. These 
audits will be removed if you select to Purge All.  If you select to purge all without a filter, 
every audit will be deleted. 

 Refresh:  Refreshes the list of audits. 

FIELDS 
 
The main body of the tab displays the logs that have been created since the last purge. There are five 
fields in the main body of the Audit tab. 
 

Action: The action performed.  
 
Line: The line of business. No Line means that this was a system action, for example, logging in 
or out of the system. 
 
Program: The name of the program where the action took place. No Program name means that 
this was a system action. 
 
Version: The program version number where the action took place. No Program Version number 
means that this was a system action. 
 
Date: The time stamp of when the action tool place. 
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Right Click Menu 
 
There is a right click menu available on every audit log. 
 

 
Figure 12 Audit Listing Right Click Menu 
 
The right click menu contains two options: 
 

● View Audit Report: This option will display the audit report for this audit log only, in a printable 
form. If you do not need to print out an audit report, double click the log and view the audit details 
at the bottom of the screen. 

 
● Delete Audit: This option will delete the selected audit log only. Use this feature to delete logs 

that will not be removed in a purge, such as purge logs and Control Tag Audit logs. 
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FILTERING 
 
Filtering allows you to filter audit logs by specific criteria. When you select a filter, any audit logs with that 
criteria will be returned to the screen. Results are listed newest to oldest. The results on the screen can 
then be used to create an Audit Report or be purged. 
 

 
Figure 13 Filter Selection 

 
Action: You can filter by words found in the action description. For example, Login, Save, Delete or 
Control. You do not have to enter the entire phrase. You can enter New and any action description with 
the word New in it will be returned. Your filter options will depend upon the level of auditing the group has. 
If your group(s) has high auditing, more audit logs will be created and you will have more types of actions 
you can filter on. 
 
Line Desc: You can select an active line of business from the drop down menu or you can click the 
Custom link to enter in your own description.  
 
Program ID: You can enter in the exact program ID. Only exact matches will be returned. 
 
Program Ver: You can enter in the exact program version. Be aware that program versions are not 
unique. If you enter in 1, you may get many results for program version 1 from multiple lines of business 
and multiple programs. Only exact matches will be returned. 
 
User FirstName: You can enter in a user first name up to 20 characters. Only exact matches will be 
returned. 
 
User LastName: You can enter in a user last name up to 20 characters. Only exact matches will be 
returned. 
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From Date: Dates can be entered in mm-dd-yyyy format. Only entering in a From Date will return audit 
logs from that date until current. Date ranges can be returned by entering in both and from and to dates. 
 
To Date: Dates can be entered in mm-dd-yyy format. Only entering in a To Date will return all audit logs 
from the beginning of the audit log until that date. Date ranges can be returned by entering in both and 
from and to dates. 
 
Control Number: You can enter in the exact Change Control number or tag used when creating the new 
revision. This is helpful if you want to make sure all changes were done against a particular change order. 
You do not have to go into each element to search. You can come here, enter in the change control 
identifier and view the list here. You can also do an action filter by the word Control to get a listing of all 
change controls.  
 
 
 
To Set Filtering 
 
NOTE:  Line of Business 0 is Workflows. To serach for Workflow items, you must do a custom search. 

Change the Line Desc field to custom and enter in a 0. Click OK to search. 
 

1. On the Audit tab, click FILTER. This will pull up a filter screen where you can enter criteria that 
will narrow your audit results.  

 
● You can choose one or more filters.  
● Filters remain in place until your remove them or leave the tab. 
● To clear a filter, click the Clear button. After you clear a filter, all Audit Logs will be 

returned. 
 
2. After you have entered your filters, click OK to view your results. 

 

 
Figure 14 Filtered Audit Listing Results 
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AUDIT REPORT 
 
An audit report for all audit logs currently displayed on all pages by filter criteria can be produced. If you 
want an Audit Report for all audit logs, make sure the filter has been cleared. If you want an Audit Report 
for a specific type of audit log, make sure to filter by that criteria. 
 

 
Figure 15 Audit Report 
 

Creating an Audit Report 
 
To create an Audit Report, enter in the criteria you want to filter by and click Audit Report. Reports will be 
displayed in the Insbridge Document Viewer. These reports are read-only. Reports can be saved to your 
local hard drive or network or printed. No editing can be done on the Insbridge Document Viewer. 
 
NOTE:  When you do a “Save As” from the Insbridge Document Viewer, you should rename the file. By 

default, when you go to save a file in the Insbridge Document Viewer, everything will be named 
“InsbridgeDocument”. It is recommended that you re-name the file. 
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Report Details 
 
The report will contain details for each of the audit logs included, starting with the newest. Each log will 
have action information, defining the action taken, the user and the date. Program information, such as 
LOB, program, program version, and program ID, may be included. If applicable, element/item information 
including description, revision and ID may be included. 
 
NOTE:  OBI Publisher must be installed and running in order for Program and Program Version Reports 

to be displayed. If you receive an OBI Publisher error, please contact your system administrator. 
 
 
Audit Preview 
 
To view a specific audit, double click the line. The audit report details will be displayed in Preview 
Window located in the lower portion of the tab. 
 

 
Figure 16 Audit Log Preview Screen 
 
The preview window can be sized by dragging the separation bar between the audit list and the preview 
window. The preview window will update to show the currently selected audit log. 
 
NOTE:  If logs are not displayed, please verify that the Insbridge Messaging Service is on. If the Insbridge 

Messaging Service is off, logs will not be displayed. 
 
Individual logs can be viewed or deleted. 
 

PURGING AUDIT LOGS 
 
Audit logs can be purged at any time. Audits can be removed one at a time or in bulk. Clicking Purge All 
will remove all audit logs currently displayed on all pages by filter criteria. For example, if you have run a 
filter for all logs created on June 23, 2009, the screen will display all logs created on that day only. The 
logs may consist of one page or many pages. If you click Purge, all logs for June 23, 2009 will be purged. 
No other logs will be purged. To view remaining logs, clear the filter. 
 
If you want to purge all audit logs, do not place a filter on the list. If you only want to purge selected items, 
place a filter on the list. Purge will only remove the audit logs that are displayed on the Audit Listing 
screen. 
 
If you want to remove one audit, use the right click menu to delete. 
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To Purge Bulk Audits 
 

1. If you have a specific audit type or group of actions you want to remove, set a filter for the bulk 
audits you want to remove. 
 

2. When the audits you want to remove are displayed, click PURGE ALL. 
 

 
Figure 17 Purging an Audit List 

 
3. Click OK to remove the all audits currently displayed. Click Cancel to return to the previous 

screen. 
 
NOTE:  Purge Logs and Control Tag Audit logs will not be purged in bulk. These logs must be removed 

one at a time using the right click menu. 
 
 
To Purge One Audit 
 

1. To remove one single audit that is no longer required, highlight the audit. 
 

2. Right click and select DELETE AUDIT from the menu. 
 

 
Figure 18 Purging an Audit List 

 
3. Click OK to remove the log. Click Cancel to return to the previous screen. 
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Chapter 4 

IMPORT PROGRAMS 
 
The Imports screen allows you to import all elements related to a program including the following:  
 

● Global Input Variables 
● Global Result Variables 
● Local and Global Mapped Variables 
● Local and Global Calculated Variables 
● Local and Global Algorithms 
● Sequencing 
● Program Versioning 
● Categories 

 

 
Figure 19 Imports 
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Import Program can only create a new program, with a new program ID. You will not be able to restore 
over an existing program for safety reasons. You can delete the incorrect program and import the correct 
program. 
 

FUNCTIONALITY 
 
The Menu Bar is located at the top of the tab. The menu bar contains the functions you can perform on 
this tab. 
 
 
Functions: 
 

 
Import:  Opens the Program Import Wizard. This wizard will guide you through the 
import process and allow you to create new elements. 

 Delete:  Removes the selected program from the Import Programs tab. 

 Upload From File: Uploads files from your local hard drive or network. 

 
Save To File:  Allows you to save an import program to your local hard drive or 
network. 

 Refresh:  Refreshes the list of imported programs. 
 

FIELDS 
 
The Import Programs tab displays the programs that have been imported and are ready for importing. 
There are six fields in the Import Programs tab. 
 

Check box: A check here will select the program from importing or deletion. 
 
Export Name: The new name of the exported file. This name cannot be changed. 
 
Program Name: The original name of the exported file.  
 
LOB: (Line of Business) – The line of business where this file was exported from. 
 
Export Date: The date the file was exported. 
 
Size: The size of the file. 

 
 
Navigating to Import Programs  
 

1. Select Tools Import Programs. 
 

2. This will open the Import Programs tab. 
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Right Click Menu 
 
A right click menu is available for exported files. 
 

 
Figure 20 Right Click Menu for Import 
 
The right click menu contains: 
 

Get Summary: Pulls up the summary page from the program. 
 
Import Program: Allows you to launch the import wizard. 

 
 
Get Summary 
 
Get summary displays a summary report of the export including line, program name, program ID and 
export information.  
 

 
Figure 21 Get Summary 
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IMPORT WIZARD 
 
The Import Wizard allows you to import programs into RateManager. The Import will be into the same line 
of business that the program has been exported from. This is done automatically and you do not need to 
make any selections. 
 
If the exported line is not activated in the importing subscriber’s RateManager, the Exported Program 
Summary will display No LOB found for the Line of Business information. You will have to activate or 
create the line of business before this program can be imported. If you attempt to import a non-activated 
line, an error message will be displayed. The error message will display the LOB ID number that you 
need to activate or create. 
 
 
Sublines and Imported Programs 
 
Lines are separated into sublines. Sublines are classifications that fall in between lines and program 
folders. Sublines will allow you to distinguish program sources and also keeps the globals unique within 
that subline. Globals are subline specific and are not shared across sublines. There are two types of 
sublines, default and template generated. 
 

 - Indicates the Default subline 
 

 - Indicates Template generated sublines 
 
You will have one default subline. This is the subline created for your subscriber ID. Any program in any 
subline can be exported to the Import tab. Exported programs can be saved to your local hard drive or 
network and then imported back in to your RateManager system or another RateManager system.  
 
Template generated sublines are created when you apply a template or import a program that was 
created outside of your subscriber ID. Programs exported from different subscribers will create a new 
subline when imported. For example, if you import a template from subscriber Alamere, you will create a 
subline Alamere. If you import another template from subscriber Insurco, you will create another subline 
Insurco. You can have many template generated sublines. 
 
Only one subline per source will be created. Templates and Imports will reside in the same subline. A 
Program folder will be created with each subline. Additional folders and programs can be added to the 
subline. 

Launching the Import Wizard 
 
To Import a program, select an export program from the list. If no export programs are listed, you can 
upload from a file or return to the folder and export one. Click IMPORT. The wizard will launch in a 
separate window.  
 

NOTE: 

Throughout the Import: 
 
A black arrow  indicates the current step in the import progress 
 
A green checkmark  indicates that the step has been completed. 
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Import Wizard Screen 1 – Welcome 
 
The welcome screen gives you information about the import functionality and prompts you to backup the 
database before executing the import. A backup is strictly for safety reasons, and while not required, it is 
recommended.  
 

 
Figure 22 Import Wizard, Screen 1 
 
Click NEXT to continue.  
 
NOTE:  At any time, you can click CANCEL to cancel out of the wizard. Click HELP for online help. 
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Import Wizard Screen 2 – Configure Program Import 
 
The Configure Program Import screen allows you to enter in a name for the import and select the folder 
where the import can be brought into. You also can choose whether or not you want to see every screens 
progress or only the issues that need to be resolved.  
 
The left side of the screen will let you know the progress of the import process. 
 

 
 

1. Select the folder that the program is to be imported in to.  
 

2. Enter in a New Program Name if needed. 
 

3. Select if you want to enter a configurable program ID number or if you want to the system to auto 
select one for you. You can check if the ID is used or available by entering your program ID and 
clicking the Check if used button. An answer will be returned to you immediately. 

 
4. Next you can choose:  

 
● If you want the import wizard to proceed from this screen and only stop on items that 

need to be resolved. 
● If you want the import wizard to proceed from this screen and stop on every screen that 

has applicable variables, regardless if the variables and/or algorithms need to be 
resolved. 

 
5. Click NEXT to continue. 
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Import Wizard Screen 3 – Verify Information 
 
The Verify Information screen is a summary of the program to be imported, and the naming conventions.  
 
This is the same information you can get by right clicking on the Export Program name and selecting Get 
Summary. 

 

 
Figure 23 Import Summary Screen 
 

1. Verify the data before continuing with the import. This screen is the last place you will be able to 
go backwards and make corrections before the import commences. 

 
2. Click NEXT to continue.  
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Import Wizard Screen 4 – Resolving Categories 
 
If you have selected to stop or if an issue has risen, then the Resolving Categories screen will be 
displayed.  
 

 
Figure 24 Import Wizard Resolving Categories 
 
Category Rules: 
 

● If a category does not exist, the system will prompt you to create it. 
 

● If you would like to map an existing imported category to a different category, you will be able to 
select from a list of existing categories via a category drop-down. 

 
● Valid Statuses:  

  Not Found: If an imported category is not found in the existing database the status will be 
“Not Found” 

  Found: If an imported category is found in the existing database the status will be “Found” 
 

● Valid Actions:  
  Create: If the user would like to create a new category the action shall read “Create” 
  Replace: If the user would like to replace an imported category with an existing category the 

action shall read “Replace” 
  None: There is no action taken, which is the default when a category is found. 

 
3. After resolving any issues, click NEXT to continue. 
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Import Wizard Screen 5 through Screen 9 
 
Screens 5 through 9 all function in the same way, only stopping when an issue arises. In order to 
continue, the issue must be resolved.  

 
● Screen 5 – Global Inputs  
● Screen 6 – Global Result Variables  
● Screen 7 – Global Mapped Variables 
● Screen 8 – Global Calculated Variables 
● Screen 9 – Global Algorithms 

 

 
Figure 25 Resolving Issues on the Import Wizard 
 
Screens 5 through 9 have the same statuses and actions. 
 

● Valid Statuses: 
  Not Found: If an imported Global Variable or Algorithm is not found in the existing database 

the status will be “Not Found” 
  Found: If an imported Global Variable or Algorithm is found in the existing database the 

status will be “Found” 
 

● Valid Actions: 
  Create: If the user would like to create a new Global Variable or Algorithm the action shall 

read “Create” 
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  Replace: If the user would like to replace an imported Global Variable or Algorithm with an 
existing Global Variable or Algorithm the action shall read “Replace” 

  None: There is no action taken, which is the default when a Global Variable or Algorithm is 
found. 

 

 
Figure 26 Replacing a Not Found Input with an Existing Input 
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Import Wizard Screen 10 – Processing Immediately 
 
The import will immediately process. You will receive a processing screen.  
 

 
Figure 27 Processing Time for Import 
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Import Wizard Screen 11 - Finished 
 
When the process is finished, you will receive a screen letting you know if the import was successful or 
failed.  

 

 
Figure 28 Successful Completion of an Import 
 

Global Imports 
 
When a Global Variable or Algorithm is imported inside a program, it can not been undone via the import 
process. By default, the import does not override any conflicting data. 
 
There is no indication in the RateManager Global Variable or Global Algorithm listing that a Global 
Variable or Algorithm has been imported.  
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Deleting Programs 
 
Programs can be deleted from Imports at any time.  
 
 
To Delete: 
 

1. Select the Program. 
 

2. Click DELETE. A warning message will be displayed. 
 

 
Figure 29 Deleting an Export Program Warning Message 

 
3. Select OK to delete. Click Cancel if you do not want to delete this program. 

 

Upload Files 
 
Program files can be uploaded directly into Imports. You can upload a program export from a .pxf file. 
Please note that all .pxf files are encrypted. You can upload any program from any line of business. 
 
 
To Upload a File: 
 

1. Click UPLOAD FROM FILE. A separate popup will be displayed. 
 

42 



Chapter 4 – Import Programs 

 
Figure 30 Uploading Program 
 

2. Click the Browse… button to access your computers dialogue box. 
 

 
Figure 31 Selecting File to Upload 
 

3. Select the program you want to upload and click Save. You will be returned to the Uploading 
Program box. 

 
4. Click the Upload button. The process will begin. 

 
When the program is finished uploading, the popup will close and the program will be listed on the Import 
Program screen. 
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Saving Files 
 
You can save a program in the Import Programs tab as a .pxf file on your local hard drive or network.  
 
 
To Save a File 
 

1. Select the file you want to save. 
 

2. Click SAVE TO FILE. Your computers dialogue box will be displayed. 
 

 
Figure 32 Saving a Program 
 

3. Click Save and select the folder and location where you want to save the program. 
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Chapter 5 

SECURITY 
 
Any administrator may configure RateManager security settings. Usernames and groups can be created 
and system rights assigned. Groups can be created to grant users access to specific lines of business 
and specific screens within that line of business (variables, algorithms, etc.), with or without write access. 
Groups also can be given access to specific modules, Testing or Impact Analysis. 
 
Security can be found on the Tools menu. There are three options you can select: 
 

● User Management 
● Group Management 
● Session Management 

 

USER MANAGEMENT 
 
The user management tab allows an administrator to add, edit and delete users. This portion of 
RateManager is only available to users who are members of the Administrator group. 
 
Company Administrator will be the only user in a new system. All other users must be created. The 
Company Administrator cannot be deleted nor have their rights edited.  
 

 
Figure 33 User Management Screen 
 
From here, you can: 
 

● Add a User 
● Edit a User 
● Delete a User 
● Reset a User Password 

 
 
Navigating to User Management  
 

1. Select Tools Security User Management. 
 
2. This will open the User Management tab. 
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FUNCTIONALITY 
 
The Menu Bar is located at the top of the tab. The menu bar contains the functions you can perform on 
this tab. 
 
 
Functions: 
 

 New:  Opens up the Create User tab where new users can be added to the system. 

 
Edit: Opens up the Edit User tab where user information can be updated and user 
password reset. 

 Delete: Deletes the selected user. 

 Refresh:  Refreshes the list of users. 

FIELDS 
 
The main body of the tab displays the users that have been created. There are three fields in the main 
body of the User Management tab. 
 

Name: The first and last name of the user.  
 
Contact Info: The phone number and email address of the user. The email address will be 
hyperlinked, allowing you to create an email for this user. 
 
Last Login: The time stamp for the last date and time the user logged into the system. 

 

ADDING A USER 
 
New users can be added from the Add User tab. All new users will be assigned the default password, 
password. New users should log in as soon as possible and change their password. 
 
There are two icons and two buttons located on the tab. 
 

 
Required:  A red asterisk indicates that this field is required. You will not be allowed to 
save your entry unless all the required fields are complete. 

 
Information: Hover your cursor over the information icon to see more information about 
the entry. 

 
Save: Saves your entry. The Save option is located in the lower right hand corner of the 
tab. 

 
Cancel:  Cancels any changes and returns you to the User Management tab. The 
Cancel option is located in the lower right hand corner of the tab. 

 
 

NOTE: Prior to creating a user, make sure you have your user groups created. 
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To Add a New User 
 

1. Navigate to the User Management tab. 
 

2. Click NEW to open the Add User tab. 
 

 
Figure 34 Adding a New User 
 

3. Select the Group(s) the new user will belong to by selecting a group or groups from the Select 
Groups list and then clicking the  button.  

 
4. Select the Company the user will belong to from the drop down listing. 
 

Subscriber information may be needed by users when logging into the system. If more than one 
subscriber was created, users must be directed to the subscriber where their logins were created. 
Subscriber information is necessary for custom XML creation and testing and is also needed for 
Libraries. 
 
If you have not created subscribers in IBFA, you will not be able to assign users to a company. 

 
5. Enter a First and Last name for the user in the appropriate text boxes. 
 
6. Enter a Username for the new user. The username must be at least six, but fewer than twelve, 
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alphanumeric characters and can include an underscore (_) or period (.). 
 
7. Enter a Department for the user. 
 
8. Select whether the new user is a Network User by selecting True or False from the drop down. If 

you select True, the user's credentials (username and password) will be validated using Windows 
Authentication Tokens. The username must match the network user ID.  If you select False, the 
user must enter a valid username and password via the RateManager login screen. 

 
9. Optionally, enter a Phone Number and Email Address for the new user. 

 
10. If you want the user's password to expire, click the box next to Password Expires. The 

Preferences screen will contain the number of days required for a password change. 
 
11. When you are finished, click SAVE. The user will be added to the system and the user list will be 

updated. The new user can now log in using the username you assigned them and the default 
password, password.  

 
12. The user should change their password the first time they log in. See Changing Your Password 

for more information. 
 

EDITING A USER 
 
This section allows an administrator to change a user's information such as their email address or phone 
number. It also allows for a user’s password to be reset. 
 
 
To Edit a User 
 

1. Navigate to the User Management tab. 
 

 
Figure 35 User Management for Editing a User 
 

2. Select the user you want to edit and click EDIT. You also can edit a user by double-clicking their 
name.  

 
3. This will open the Edit User tab. This screen is similar to the Add User tab and all information can 

be edited, with the following exception: the reset password option. 
 

4. When you have finished making changes, click SAVE to update the user's information and 
refresh the user listing. If you do not want to save your changes, click CANCEL. 
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Resetting User Passwords 
 
You have the option to reset a user's password. If a user forgets their password, you can reset it on the 
Edit User tab. 
 
 

 
Figure 36 Resetting a Password 
 

1. Navigate to the User Management tab 
 

2. Select the user whose password you want to reset and click EDIT. This will open the Edit User 
tab. 

 
3. Scroll to the bottom of the tab and check the reset password box. The user's password will be 

reset to the default password, password.  
 

4. Click Save to save your entry. 
 
The user should change their password the next time they log in but will not be required to do so. 
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DELETING A USER 
 
If a user is no longer needed, they can be deleted. Any user at any time can be deleted. Only the Admin 
user cannot be deleted. 
 
 
To Delete a User 
 

1. Navigate to the User Management tab. 
 

 
Figure 37 User Management for Deleting a User 
 

2. Select the user you want to delete and click DELETE. 
 

3. You will be asked to confirm deletion of the user. 
 

 
Figure 38 Confirmation Message for Deleting a User 

 
4. Click OK to delete the user and refresh the user listing. Click Cancel to return to the user listing 

without deleting the user. 
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GROUP MANAGEMENT 
 
The group management tab allows an administrator to add, edit and delete user groups. RateManager 
groups are used to assign rights to a set of users. You must create groups prior to creating users. 
 
For example, you may have one group called Testers that can only access the Testing module and 
another group called AutoLoaders that only has access to the auto line of business. 
 
The Admin group is a default group and will be the only group in a new system.  This group cannot be 
deleted or edited or have their rights edited. All other groups must be created. The Admin group is the 
only group that has access to the Security module of RateManager.  
 

 
Figure 39 Group Management 
 
From here, you can: 
 

  Add a Group 
  Edit a Group 
  Edit a Group's Rights 
  Delete a Group 
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Navigating to Group Management  
 

1. Select Tools Security Group Management. 
 
2. This will open the Group Management tab. 

FUNCTIONALITY 
 
The Menu Bar is located at the top of the tab. The menu bar contains the functions you can perform on 
this tab. 
 
Functions: 
 

 
New:  Opens up the Add Group tab where new groups can be added to the system and 
auditing levels can be set. 

 Edit: Opens up the Edit Group tab where group information can be updated. 

 
Delete: Deletes the selected group. Before deleting a group, you must remove all 
members from the group. 

 Rights: Opens the Rights screen where you can manage group’s rights. 

 Refresh:  Refreshes the list of groups. 

FIELDS 
 
The main body of the tab displays the groups that have been created. There are four fields in the main 
body of the Group Management tab. 
 

Name: The name of the group.  
 
Description: A description of the group. 
 
Location: The location entered for the group. 

 
Users: The number of users in this group. 

ADDING A GROUP 
 
New groups can be added from the Add Group tab at any time.  There are two steps to creating a group: 
 

  Step 1: Add the Group – This step creates the group and allows you to add information about 
the group. The step is performed on the Add Group tab. 

 
  Step 2: Assigning Group Rights – This step defines the permissions this group will have. This 

step is performed on the Group Management tab Rights screen. 
 
On the Add Group tab, there are two icons and two buttons located on the tab. 
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Required:  A red asterisk indicates that this field is required. You will not be allowed to 
save your entry unless all the required fields are complete. 

 
Information: Hover your cursor over the information icon to see more information about 
the entry. 

 
Save: Saves your entry. The Save option is located in the lower right hand corner of the 
tab. 

 
Cancel:  Cancels any changes and returns you to the User Management tab. The 
Cancel option is located in the lower right hand corner of the tab. 

 
 
To Add a Group 
 

1. Navigate to the Group Management tab. 
 

2. Click NEW to open the Add Group screen. 
 

 
Figure 40 Adding a Group 
 

3. Enter a Name for the new group. The name can be any combination of alphanumeric characters, 
with one to fifty characters. Blanks, periods, underscores, etc. are not allowed. 
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4. Optionally, enter a Description, Location and Email address for the new group. 
 

5. Check if you want Auditing for this group.  
  

6. When you are finished, click SAVE. The group will be added and the group list will be updated. 
Users can now be assigned to the group through User Management. 

 
 
Auditing 
 
Auditing is set at the group level and applies to all members of the group. If a user is assigned to more 
than one group, auditing will apply to the group(s) that has it activated. 
 
There are three levels of auditing: 
 

1. None: Auditing will not be tracked for the group. 
 

2. Normal: All saves and deletes for the group will be tracked. 
 

3. High: All new items, saves and deletes for the group will be tracked. 
 
If auditing is set to normal or high, a log will be kept for changes and actions done by each member of the 
group. If auditing is set to none, no logs will be kept. Audit logs are displayed in the Audit module. 
 
Auditing is also displayed in the View History report. The View History report will contain audit logs for the 
users who have auditing in place. For example, if your RateLoading group has auditing set to high and 
your BA group has no auditing, the View History report will only contain the actions done by the 
RateLoading group. Since the BA group did not have any auditing turned on, none of their changes or 
actions will be listed in either the Audit Module or the View History report. The level of auditing will 
determine the detail of the View History report.   
 
 
No Permissions to Work in Lines 
 
After a group has been added, you must assign group permissions. If you do not, users will not have 
access to lines. 
 
If a user does not have access to lines of business, they are not assigned to a group that has the proper 
permissions. Have the user close out of their session prior to changing their group or group permissions. 
 

 
Figure 41 Users Denied Access to Lines 
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Group Rights 
 
Group Rights are broken into areas and lines of business. You can allow users access to the entire 
system or just certain modules. You also can restrict users from performing certain actions, such as 
packaging or creating folders. 
 

User Actions 
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Permissions to Grant 
RateManager Workflow 

Programs –  X    
Write Access –   X   

Scenario –  X    
Write Access –   X   

Workflow Mapping –  X    
Write Access –   X   

Inputs –  X    
Write Access –   X   

Workflows – X    
Write Access –   X X  

RateManager Package Admin 
Program Export – Allows users to export programs. X X   
Program Import – Allows users to import programs. Found in Tools Import. X X   
Release Management – Allows users to access the Releases Module. X X   

Database Support  
Backups – Allows users to create database backups within RateManager. X X   
Restores – Allows users to restore databases within RateManager. X X   

LOB  
Variables –  X    

Write Access –   X   
Algorithms –  X    

Write Access –   X   
Driver Assignment – AUTO LOB ONLY X    

Write Access –   X   
Sequencing –  X    

Write Access –   X   
Output Mapping –  X    

Write Access –   X   
Inputs –  X    

Write Access –   X   
Categories –  X    

Write Access –   X   
Program Management –  X    

Write Access –   X X  
Lock Admin –     X 
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Permission to Grant Definitions 
 
There are four areas: 
 

1. RateManager Workflow – Allows users to work in the Workflows Module.  
a. Read permissions are granted to all areas in Workflows by checking any element.  
b. Write permissions are granted per element. Checking a write permission will also grant 

read permission to all areas in Workflows. 
c. Package permissions are in the Workflows section. Checking a write permission will grant 

package permissions as well as grant read permission to all areas in Workflows. 
 

2. RateManager Package Admin – Allows users to work with packages in the system. Users are 
granted full access when the element is checked. 

 
3. Database Support – Allows users to work on Database Backups and Database Restores. Users 

are granted full access when the element is checked. 
 

4. LOB – Each line of business will have rights separate from the other lines. 
a. Read permissions are granted to all areas within the line by checking any element.  
b. Write permissions are granted per element. Checking a write permission will also grant 

read permission to all areas in the line. 
c. Package permissions are in the Program Management section. Checking a write 

permission will grant package permissions as well as grant read permission to all areas in 
the line. Package permissions also allows for users to manage folders, move, copy, and 
create revisions. 

 
 
User Actions Definitions 
 
Write Access will allow users to create and edit entries. Users who do not have write access will have 
Read-Only access unless access to the entire module has not been granted. 
 

  View – Allows users to view the elements that have been created. 
 

  Write – Allows users to create, edit, copy, and delete elements. 
 

  Package – Allows users to create RateManager, SoftRater and Global Versioning packages.  
 

  Lock – Allows users to lock programs. 
 
 
Assigning Group Rights 
 
Edit group's rights when you want to change the applications and lines of business users of that group 
have access to. 
 

1. Navigate to the Edit Group tab. 
 
2. Select the group whose rights you want to edit and click RIGHTS. If an email address has been 

entered for the group, the group's name will be underlined (such as Admin). For these groups, 
click to the right of the name to select them. 

 
3. This will open the Rights Management window. 
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Figure 42 Expanded Group Rights Management Screen 

 
4. From here, you can assign rights to the group for the various modules of RateManager. Expand 

the appropriate section and place a check next to an item to give the group access to that 
section.  
 
For example, if you wanted to allow this group to access and change sections of the Auto line of 
business, you would expand RateManager Auto by clicking the  (plus box). You would then 
expand each section of Auto (Variables, Algorithms, etc.) and place a check in the Write Access 
box for each section where you wanted users to have access. If you only wanted to allow a group 
to view a section, but not make any changes, you would only place a check next to that item and 
not the Write Access box. 
 

5. When you are finished making changes, click SAVE. To cancel your changes, click CLOSE.  
 

EDITING A GROUP 
 
Edit a group when you want to change the group's name, description, location or email address. Any 
changes will apply to all members of the group. 
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To Edit a Group 
 

1. Navigate to the Group Management tab. 
 
2. Select the group you would like to edit and click EDIT. You also can edit a group by double-

clicking it. If an email address has been entered for the group, the group's name will be 
underlined (such as Administrator). For these groups, click to the right of the group name to 
select it or click the underlined name to send the group an email. 

 
3. This will open the Edit Group tab. 

 

 
Figure 43 Editing a Group 
 

4. All fields can be edited. Make your changes. 
 
5. When you have finished making changes, click SAVE to update the group's information and 

refresh the group listing. If you do not want to save your changes, click CANCEL. 
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DELETING A GROUP 
 
If a group is no longer needed, it can be deleted. Only groups that currently have no users assigned to 
them can be deleted. 
 
 
To Delete a Group 
 

1. Navigate to the Group Management tab. 
 
2. Select the group you want to delete and click DELETE. 

 
3. If the group currently has users assigned to it, you will receive an error.  

 

 
Figure 44 Error Message for Deleting a Group 

 
4. Remove all users from the group by either deleting the users or assigning the users to another 

group (see Editing a User) and then try your delete request again. 
 

 
Figure 45 Deleting Group Confirmation Message 

 
5. If the group does not have any users assigned to it, you will be asked to confirm deletion of the 

group. 
 
6. Click OK to delete the group and refresh the group listing. Click Cancel to return to the group 

listing without deleting the group. 
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Group Management Tab 
 
A completed Group Management tab will list the groups, the location of the group and the total number of 
members in each group.  
 
The number of users may be greater than the total number of users. Users may be assigned to more than 
one group. 
 

 
Figure 46 Completed Group Management Tab 
 
 
Viewing Group Contact Information 
 
If you have entered any contact information for the group, you can view that information by hovering your 
cursor over the group name. 
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SESSION MANAGEMENT 
 
The Session Management tab allows an administrator to view users who currently have a RateManager 
session open and disconnect them to free up a locked element. 
 

 
Figure 47 Session Management 
 
From this tab you can: 
 

● Deactivate a License 
● Display the users who have an Element or Program Lock 

 

FUNCTIONALITY 
 
The Menu Bar is located at the top of the tab. The menu bar contains the functions you can perform on 
this tab. 
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Functions: 
 

 
Deactivate License:  Deactivates the license of the selected user. This will 
immediately end their session. 

 
Edit: Unlocks a locked element by forcing an edit tab to close. Any changes made 
on a forced close tab will not be saved. 

 Refresh:  Refreshes the list of open sessions. 

FIELDS 
 
The main body of the tab displays the sessions that are currently open. There are four fields in the main 
body of the Session Management tab. 
 

Checkbox: Check this box to perform an action on this session. 
 
User: The name of the user who has a session open.  
 
Issue Date: The time stamp that the session began. 
 
Comments: The IP or URL of the open session. 

 
 
To Navigate to Session Management 
 

1. Select Tools Security Session Management. 
 

2. This will open the Session Management tab. 
 

DEACTIVATING A SESSION 
 
If a user quits RateManager without first logging out, their session may remain open. In this event, you 
need to deactivate the session. Deactivating a session will also release any locked elements that this 
user may have outstanding. 
 
 
To Deactivate a Session 
 

1. Navigate to the Session Management tab. 
 

2. Place a checkmark next to each session you want to deactivate (free up) and then click 
DEACTIVATE LICENSE.  

 
3. You will be asked to confirm the deactivation. 
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Figure 48 Confirming a Deactivation 

 
4. Click OK to deactivate the session or Cancel to return to the Session Management tab. 

 

UNLOCKING ELEMENT LOCKS 
 
The system administrator can end the session of the user who is locking an element. This will free the 
element up allowing other users to access the element. You can view information about who has an 
element locked by hovering your cursor over the In-Use icon found on the Program Details tab. 
 
The Locked Items by User box is for information only. No action can be performed here. If you need to 
end this user’s session, you can deactivate the session. This will free the element up. 
 

 
Figure 49 User Session with Extended Locked Element 
 
To view a locked session, place a check mark in the box next the user and click License Locks. A popup 
window will be displayed indicating which element the user has locked and for how long. 
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DATABASE 
 
The Database Module can be found on the Tools menu. The Database module is where you manage 
database functions from within RateManager. There are two options you can select: 
 

● Backups – used for creating and restoring database backups. 
 

● Updates – a listing of available updates for this version of RateManager. 
 

BACKUPS 
 
The backup tab located in the DataBase option of RateManager allows an administrator to create and 
restore backups of the RateManager database.  You must be a Disk Admin to perform backups or 
restores. 
 

 
Figure 50 Database Backups 
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FUNCTIONALITY 
 
The Menu Bar is located at the top of the tab. The menu bar contains the functions you can perform on 
this tab. 
 
 
Functions: 
 

 Create Backup: Creates a backup of the currently selected database. 

 Restore Backup: Restores the currently selected database. 

 Delete Backup: Deletes the currently selected database. 

 Refresh:  Refreshes the list of backups. 
 

FIELDS 
 
The main body of the tab displays a list of the current backups. There are six fields in the main body of 
the DB Backups tab. 
 

Checkbox: Check this box to perform an action on this backup. 
 
Type: The type of backup performed, either Maintenance or Error.  
 
Name: The name of the database being backed up. 
 
Location: The location of the backup. 
 
Date: The time stamp of the backup. 
 
Size: The size of the backup. 

 
 
Navigating to Database  
 

1. Select Tools Database Backups. 
 
2. This will open the Backups tab. 

 

CREATING A BACKUP 
 
If you need assistance implementing logic or an error is found in the system, a backup or snapshot can 
be made of the database. That snapshot can then be sent to Oracle Insurance Support, where it will be 
restored. Our support personnel and analysts can then work from the snapshot to determine the best way 
to implement logic or diagnose a problem. 
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To Create a Database Snapshot 
 

1. Navigate to the Backups tab. 
 

2. Click CREATE BACKUP. This will open the RateManager Backup window. 
 

 
Figure 51 Creating a Backup 

 
3. Select the database you want to backup, either security or rm (RateManager). When creating a 

backup to send to Oracle Insurance, select your rm database. The Name on the screen will 
default to the actual name of the database in SQL Server. 
 

4. Select a reason for the backup, either Maint (maintenance) or Error. 
 

5. Enter a location where the backup should be stored. This location should be a network share. 
 

6. Click BACKUP to start the backup process. 
 

7. You will be informed when the backup operation is complete.  
 

 
Figure 52 Successful Backup Message 
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8. Your backup should be listed on the backups tab. If your backup is not listed, click REFRESH to 
refresh the screen.  
 
 

Sending to Oracle Insurance 
 
If necessary, you may need to send it to Oracle Insurance Support for assistance. 

 
1. Once the backup is complete, you can browse to the backup location you entered in Step 5. Sort 

the listing by Date Modified to quickly find the backup you just created.  
 

2. If necessary, Oracle Insurance Support will instruct you how to handle the database handoff. 
 

RESTORING A BACKUP 
 

1. If there’s a backup that needs to be restored, highlight the backup you want to restore and click 
RESTORE BACKUP. A warning message will be displayed.  

 
NOTE:  If you require assistance or are unsure of whether or not to restore a backup, please log a 

Service Request using My Oracle Support at https://support.oracle.com/. 
 

 
Figure 53 Restore Warning Message 

 
2. Click RESTORE to restore the backup or CLOSE to return to the previous screen. 
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DELETING A BACKUP 
 
If there’s a backup that you no longer need, you can delete it. Highlight the backup you want to remove. 
Click. A warning message will be displayed. Click OK to remove the backup or Cancel to return to the 
previous screen. 
 

 
Figure 54 Deleting a Backup 
 
 
Permissions Error 
 
If you do not have the proper permissions to run database backups or restores, you will receive an error 
message. 
 

 
Figure 55 Permissions Error Message 
 

68 



Chapter 6 – Database 

UPDATES 
 
The database module also contains an update tab that lists the available updates for this version of 
RateManager. 
 
From this tab you can view the update script or execute the update. Updates cannot be deleted. 
 
NOTE:  Only a database owner can perform updates. If the Updates tab or any execute buttons are not 

visible, you do not have access to the database. 
 

 
Figure 56 DB Updates 

FUNCTIONALITY 
 
The Menu Bar is located at the top of the tab. The menu bar contains the functions you can perform on 
this tab. 
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Functions: 
 

 Execute Update Script: Runs the selected update script. 

 
Open Update Script: Opens the selected update script in a 
window where it can be viewed or copied. 

 
Save Update Script to File: Allows you to save the update script 
to your local hard drive or network. 

 Refresh: Refreshes the list of updates scripts. 

 
Show Updates for: Allows you to select the update scripts you 
want to view, IBRM or IB_CLIENT. 

 

FIELDS 
 
The main body of the tab displays a list of database updates. There are four fields in the main body of the 
DB Updates tab. 
 

Script: The name and version of the script. 
 
Release Date: The date of the release for the script.  
 
Database: The type of database the script is for, IB_CLIENT or IBRM. 
 
Status: The status of the update. Current will be on the line of the most current database. 

 
 
Navigating to Database  
 

1. Select Tools Database Updates. 
 
2. This will open the Updates tab. 

 

EXECUTING UPDATE SCRIPT 
 
Database updates can be done on the IB_CLIENT database and the IBRM database. If you log into 
RateManager and Tools is the only option, you must perform a database update. 
 
On the Updates tab, the current version will be highlighted and the status will be Current. The updates 
below the current version will be grayed out. These updates cannot be run again. You will receive an 
error message if you attempt to run a lower version update. Any version update above the current version 
will also be grayed out but will be available for executing after the preceding update has been run. 
 
Updates have to be installed sequentially, meaning if you are on Version 3.9, you must run the 3.10 
update, then the 3.11 update, the 3.12 update, the 3.13 update and finally the 4.0 update. If you attempt 
to run an update that is more than one level above the current version, you will receive an error message. 
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NOTE:  It is strongly recommended that database updates be performed in RateManager. 
 
 

1. Navigate to Tools Database Updates. 
 

2. The Updates tab will be displayed. Select the database you want to view from the Show 
updates for drop down. The database updates for your selection will be listed. The last column, 
the Status column, will show you which update is the Current one installed. 

 

 
Figure 57 Available Updates 
 

3. There are two ways to execute an update: 
  

a. Directly in RateManager 
b. In SQL Server 

 
 
Directly in RateManager 
 
This is recommended way to update a database. It is recommended that you start by selecting the update 
showing Current. This will assure that the database showing as Current will have all possible updates. 
 

1. Highlight the update you want to run.  
 
2. Click EXECUTE UPDATE SCRIPT. A warning message will be displayed.  
 
3. Click OK to run the update or Cancel to return to the previous screen.  
 
4. Do this for both the IBRM database and the IB_CLIENT database. 
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Figure 58 Updating Scripts in RateManager 
 
 
In SQL Server Using Query Analyzer 
 
This method should be performed by a database administrator. You must have access to the SQL 
Server instance where the RateManager databases are located. No warning message will be 
displayed if you execute scripts in the wrong order. You must know the name of the databases you 
are updating. If you are unsure, do not use this method. 
 
WARNING: Running updates in a non-sequential order may result in severe database errors. No error 

messages will be displayed if you run updates in an incorrect order. 
 

1. In RateManager, highlight the update you want to run. If you are going from a much lower version 
of RateManager, you may have to save multiple files for each database.  
 

2. Click SAVE TO FILE. Your computers dialogue box will be displayed. Save the file to a location 
of your choice. For IBRM scripts, it is recommended that you rename the file to 
usp_IBRM_R0(version number).sql. For example the V3.10 update would be: 
usp_IBRM_R0310.00.sql. For IB_CLIENT scripts, it is recommended that you rename the file to 
usp_IB_CLIENT_R0(version number).sql. For example the V3.10 update would be: 
usp_IB_CLIENT_R0310.00.sql.  

 
3. Open Query Analyzer in SQL Server. 

 
4. Open up the DB script updates from the download file. You can open in any program you want, 

such as Notepad.  
 
5. Select the IB_CLIENT database. Create a new query. 
 
6. Copy the DB script you opened to the query screen.  
 
7. Execute the script. Any messages will be displayed in the lower portion of the screen. Fix any 

errors before you continue. 
 
8. Updates must be run in sequential order. 
 
9. Do the same for the RM database. 
 
10. After the scripts have been run, return to RateManager. Click FILE RELOAD. The status should 

show current and the full RateManager menu should be displayed. 
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Open Update Script 
 
To view the update script prior to execution, highlight the update you want to view. Click OPEN UPDATE 
SCRIPT. The update script will be displayed in a separate screen. 
 

 
Figure 59 Script Viewer 
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REQUIRED UPDATES 
 
If you log into RateManager and Tools is the only option, you must perform a database update. 
 
Please navigate to Tools Database Updates (Tab) and run the necessary updates. You will not be 
able to continue until you run the updates. 
 

 
Figure 60 Please Run Update Scripts 
 

 
Figure 61 Menu Requiring DB Updates 
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CHANGING YOUR PASSWORD 
 
You can change your password at any time. RateManager does not prompt users to change their 
passwords.  
 
It is recommended that you change your password periodically to prevent other users from logging in and 
making changes using your user ID. 
 

1. From the top bar menu, select Tools and then click Change Password. 
 

 
 

2. This will open the Change Password window. 
 

 
Figure 62 Change Password Screen 

 
3. Enter your current password in the Old Password text box and enter your new password in the 

New Password and Confirm Password text boxes.  
 
Your password must be at least six, but fewer than twelve, alphanumeric characters. 
 

4. When you are finished, click UPDATE to update your password. The next time you log into 
RateManager, you will need to use your new password. 

 

75 



 

Chapter 8 

PREFERENCES 
 
Users with Administration rights will be able to access all options found on the Preferences screen. The 
Preferences screen allows administrators to manage settings, and set Home Page options.  
 
Non-administrators will only have the option to set their Home Page Snaps. Please see the RateManager 
User Guide. 
 

ADMIN SETTINGS 
 
Administrators can edit web settings at any time from the Preferences screen. Changes will take place 
after the user sessions have been ended. 
 
From the Preferences screen, you can set pathways, define servers, backup shares, set preferences, set 
batch threads, establish minimum ID lengths, display of override date-mask values for Importing Data for 
Mapped Variables, allow users to edit data types within the application, and set the time for inactive 
session timeout. 
 
 
To Change Settings 
 

1. Select Tools Preferences. 
 

 
 
 

2. This will open the Preferences window. Select Web Settings. This option will be displayed if you 
are an administrator. 
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Figure 63 Preferences Settings 
 

3. Make any necessary changes. 
 

4. When you are finished, click SAVE to update your settings. If you want to changes to take place 
immediately, you may have to end all user sessions.  

 

Web Settings 
 
Insbridge ConfigXml Path 
 
This is the path from IBFA. This pathway must match the IBFA path. You may need to change this path if 
you have changed the path in IBFA. Please contact Insbridge support for further information.  
 
It is strongly recommended that you leave the default.  
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Messaging Server 
 
RateManager is set up to run batches on the same server that RateManager is located on. If you have an 
especially large batch to run and you want to batch to a different server, you will have to change server 
locations here. Unless necessary, it is strongly recommended that you leave the default. 
 
 
SoftRater Server 
 
If you need to rate on another server, you will have to change server locations here. It is strongly 
recommended that you leave the default. 
 
 
Backup Share Folder Location 
 
When you make backups of the RateManager database, you can specify the location of the backup file. If 
the location is local, you will use a local path. If the location is not local, you must be a disk admin to 
change. 
 
 
Use Insbridge Com + Admin 
 
This setting must always be true. If there is a conflict, please contact Oracle Insurance support. 
 
 
Enforce Release Packaging 
 
When set to False, a release is not required in order for users to create a SoftRater (full) package. False 
is the default setting.   
 
If set to True, a release is required in order for a SoftRater (full) package to be created. If a user wants to 
create a SoftRater (full) package in the Program Explorer module, a release must be created in the 
Releases area first. This release must have the program added to it and be unlocked. When the user 
creates the SoftRater package in Program Explorer, they will have the option to select the Release they 
want this package to be placed into. If there is no release, or no release that contains that program and is 
unlocked, then the user will be able to do RateManager (local) packages only. 
 
 
Batch Package Threads 
 
RateManager allows you to change how many threads are used. Threading enables a process to finish 
faster by splitting the process into smaller processes that run quasi-simultaneously. On multiprocessor 
systems, using multiple threads enables the operating system to assign the threads to different 
processors. 
 
In addition, the Framework Administrator also enables you to change the administrator email address for 
each client. When a process fails, an email will be sent to the person who initiated the process, as well as 
to the administrator email addresses listed for the client of that process. 
 
NOTE:  Before changing the number of threads, you should consult with your system 

administrator. Setting the number too high can result in poor performance or even a 
system crash. If you are unsure of how many threads to use, set the number to 1. For 
single processor systems, Oracle Insurance recommends a maximum of 2 threads. 
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Minimum Login User ID Length 
 
This is the minimum number of characters required for a user ID. 
 
 
User must change password 
 
This where you set the number of days before a user is required to change his/her password. This setting 
will only be active when you elect to have users change their password on the user setup screen.  
 
 
Show Override Date Mask 
 
If enabled, a date mask for ‘Date’ data types will be displayed when importing a table. If not enabled, this 
field will not be visible. 
 
 
Allow Data Type Change 
 
The type of data associated with a parameter. RateManager supports three (decimal, integer and string) 
data types for variables and inputs and a fourth (date) for inputs and result variables only. 
 
Setting this option to True will allow RateManager users change the data type of a variable or input. 
Setting this option to False will not allow users to change data types. 
 
 
Inactive Session Time Out  
 
This is the amount of time that a user sits inactive before being automatically logged out of the system.  
 
 
Batch Results with New Line  
 
Allows batch results to go to a new line instead of forming one continuous string. A True setting will place 
a carriage return between result files. A False setting will result in one continuous string without a break. 
 
 
Online Help Server  
 
Online help is installed with RateManager. This setting is the default server name where RateManager 
currently resides. Either a server name or an IP address can be entered here. If needed, you can change 
the name of the server. For example, if the machine name is not the same as the host name, you may 
need to change the name in order for online help to function. 
 
 
My Recent List 
 
My Recent List is a snap setting. Snaps are modules that contain information or links to elements that the 
user recently worked on. You can set the maximum number of elements to display in a snap. The default 
is for the snap list to be limited to 10. 
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Default Proxy Script Location 
 
The Default Proxy Script Location setting may be needed if you elect to use the Oracle Insurance Blog 
Feed snap. This setting can be used for RSS feeds. 
 
 
Change Control 
 
If change control is on, it will be mandatory for users to enter a change control entry and justification to 
any element or program when it is revisioned. If change control is off, the option will not be presented. 
 
 
Maximum Amount of Simultaneously Opened Tabs 
 
Use the maximum amount of simultaneously opened tabs setting to set the maximum number of tabs you 
will allow users to have opened in RateManager. The default is 15. 
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VIEWING VERSIONS 
 
The Version option in the Tools section of RateManager allows an administrator to view the version 
information for the current system. 
 
 
To View a Version 
 

1. From the Home tab, select Help RateManager Version. 
 

 
 
2. This will open the Version Listing window. 
 

 
Figure 64 Version Listing 

 
3. The latest version information including RM schemas, IB Client schemas and build will be 

displayed. 
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CONTACTING SUPPORT 
 
 
If you need assistance with an Oracle Insurance Insbridge Rating and Underwriting System product, 
please log a Service Request using My Oracle Support at https://support.oracle.com/. 
 
 
Address any additional inquiries to: 
 
Oracle Corporation 
World Headquarters 
500 Oracle Parkway 
Redwood Shores, CA 94065 
U.S.A. 
 
Worldwide Inquiries: 
Phone: +1.650.506.7000 
Fax: +1.650.506.7200 
oracle.com 
 
 

TTY ACCESS TO ORACLE SUPPORT SERVICES 
 
Oracle provides dedicated Text Telephone (TTY) access to Oracle Support Services within the United 
States of America 24 hours a day, seven days a week. For TTY support, call 800.446.2398. 
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GLOSSARY TERMS 
 

A 
Administrator: The person designated by your company who has the authority to 

create and change groups, usernames, passwords and restrictions. 
Algorithm: A sequence of steps used to perform a calculation.  
Assigned Driver: A driver who has been assigned to a vehicle. 
Assigned Vehicle: A vehicle that has been assigned a driver. 
Authoring 
Environment 

The physical machine where RateManager is installed.  

C 
Calculated Variable: Calculated Variables are used when a result cannot best be derived 

from simple data mapping in a table. For example, if age is not passed 
as an input, but is a criteria needed in determining other factors, you 
would use a Calculated Variable to calculate driver age from the inputs 
of effective date and driver date of birth. Calculated Variables look at 
every node (driver, vehicle, location, etc.) independently and create a 
result for each. Once a calculated variable is created, the result can be 
used in any other variable. 

Callouts A set of a single or multiple programs and/or SoftLibraries that allows 
users to call needed operations at a specific time from either inside the 
system or outside the system. 

Category: A user defined group of information that defines inputs, variables, 
algorithms and the overall structure of the program. 

Criteria: An input or variable used in a mapped variable to determine which 
value to return. Any input or variable can be used as a criteria. 

D 
Data Type: The type of data associated with a parameter. RateManager supports 

three (decimal, integer and string) data types for variables and inputs 
and a fourth (date) for inputs and result variables only. 

Date: A data type supported for inputs and result variables only. For more 
information, see Dates in the Contents section. 

Decimal: A data type supported for all types of variables and inputs. Examples 
of decimal values are 3.1415, 18 and 0.995. 

Default Value: Used by a mapped variable if no match is found based on the criteria. 
Dependency: When copying a variable, algorithm or driver assignment, any element 

that requires another element to be present or defined will be listed. All 
dependencies must be resolved. 

Driver Assignment: Driver assignment is an auto insurance specific method of assigning a 
particular driver to a particular vehicle on a policy, based on certain 
criteria. Criteria often differ on a carrier basis, and sometimes even on 
a program level. 

Driver Assignment A driver assignment scenario is a list of instructions that define the 
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Scenario: main sequence of operations to properly define the driver assignment 
logic for a carrier. A scenario is based upon the same algorithm 
principle used throughout the RateManager software. 

E 
Export: Exports allow users to export all elements of a program from one 

database to another database or within the same database. Or to 
export data in tab-delimited form, from a RateManager table to an 
outside location. 

F 
Flag: A variable that holds a 1 for true and a 0 for false. 
Flag Driver Algorithm: An algorithm used by a Flag Driver Function to flag drivers based on 

certain criteria. 
Flag Driver Function: A built-in function used in the main driver assignment that defines the 

scope of the flagging operation. Most require an association with a 
predefined Flag Driver Algorithm. 

Flag Vehicle 
Algorithm: 

An algorithm used by a Flag Vehicle Function to flag vehicles based on 
certain criteria. 

Flag Vehicle Function: A built-in function used in the main driver assignment that defines the 
scope of the flagging operation. Most require an association with a 
predefined Flag Vehicle Algorithm. 

G 
Global: An input or variable that is available to all programs under a specific 

subline. 
Global Input: A value that is passed into the rating system. 
Global Result: A value that is passed out of the system after rating.  
Group: A set of users that have the same access rights. 

I 
IBFA Insbridge Framework Administrator. IBFA is an administrative tool 

used to configure Insbridge applications and setup RateManager 
database connections. IBFA will be located on a Windows Server 
machine. IBFA/SR-WIN is an Insbridge Framework 
Administrator/SoftRater for Windows.  

IBSS Insbridge SoftRater Server. IBSS is the administrative tool for the 
SoftRater engine. The SoftRater engine is a multi-platform component 
within IBRU that executes the rules, rating and underwriting 
instructions as defined by the user in RateManager. IBSS is usually 
located on a Java machine. IBSS/SR-JAVA is an Insbridge SoftRater 
Server/SoftRater for Java.  

IBRU Insbridge Rating and Underwriting System. This is the entire system.  
If: A step type available for use in calculated variables and algorithms. 

For more information, see If in the contents section. 
Import: Import allows users to bring in programs from an outside location into 

RateManager. Or to import data in tab-delimited form, into a 
RateManager table. 

Input: A value that is passed into the rating system. 
Integer: A data type supported for all types of variables and inputs. Examples 

of integer values are 3, 1859865 and -47. 
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Interpolation: An estimated value derived from two known values. 

L 
Library: The Library is where templates are stored and managed. 
Linked Variables: Two or more mapped variables that have been associated with one 

another because they use the same criteria. 
Lock: A lock will close all associated Variables, Algorithms, Driver 

Assignments, Sequencing and Result Mappings in a program version 
from deletions and edits. 

Logical Environment An environment created for a subscriber in IBFA. It defines package 
location, engine location and database location in addition to several 
other supporting data items. This environment is used for rating and/or 
SRP management. Each database connection will have a logical 
environment.  

M 
Mapped Variable: A variable that uses other variables and inputs as criteria in 

determining the appropriate value. See Mapped Variables in the 
Contents section for more information. 

Mask: A feature that allows the customer to determine how data should be 
interpreted. See Masking in the Contents section for more information. 

N 
Normal Rating 
Algorithm: 

The most common type of algorithm. Examples of what it can be used 
for are:  
● Determine premiums 
● Calculate differences in limits being passed into the system vs. 

limits being rated by the system 
● Assign tiers  

O 
Operator: A built-in mathematical function used in calculations and comparisons. 

P 
Package: A small file that holds all the RateManager logic for a specific program 

and version. 
Package Location A pointer to a location where SoftRater Packages (SRP's) are stored. 
Physical Environment A physical environment is generally referred to as a physical machine.  
Program: A planned group of procedures executed in a specific order to return a 

rating. Programs in RateManager typically correspond to rate manuals. 
Programs can be either created by the users or imported. 

Program Date Mask: Specifies how SoftRater interprets dates being passed into an input 
file. 

Program Folders: A RateManager file management system that functions in much the 
same way as Microsoft Windows Explorer. This multi level setup 
allows for an unlimited number of program folders and subfolders to be 
placed underneath a subline. 

R 
Rank Driver 
Algorithm: 

An algorithm used by a Rank Driver Function to rate drivers based on 
certain criteria. 
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Rank Driver Function: A built-in function used in the main driver assignment that defines the 
scope and sorting order of the ranking operation. Most require an 
association with a predefined Rank Driver Algorithm. 

Rank Vehicle 
Algorithm: 

An algorithm used by a Rank Vehicle Function to rate vehicles based 
on certain criteria. 

Rank Vehicle 
Function: 

A built-in function used in the main driver assignment that defines the 
scope and sorting order of the ranking operation. Most require an 
association with a predefined Rate Vehicle Algorithm. 

Rating Environment The physical machine(s) where SoftRater is installed. This is typically 
the same as a SoftRater node.  

Reconcile A comparison feature that compares one program version against 
another version in the same program and generate a report of the 
differences. 

Restrictions: Limitations on viewing and editing pages and fields in the system. 
Restrictions are assigned and changed by the Administrator. 

Result Mapping: A defined set of results, inputs and variables displayed in the output 
file. 

Revision: A variable specific type of versioning. See Versioning in the Contents 
section for more information. 

RM RateManager. RateManager is a component within IBRU that enables 
users to manage the product definition and modification process, 
including rating and underwriting logic.  

S 
Sequence: The order in which algorithms run. See Sequencing in the Contents 

section for more information. 
SoftLibrary: A SoftLibrary is a specially developed program that performs a specific 

task. SoftLibraries may run their own code or call upon other systems 
to obtain information outside of RateManager, for example, obtaining a 
credit score 

SoftRater Node A SoftRater node is either an IBFA (without RateManager) or IBSS 
instance on a physical environment.  

Source: The source is the creator of a template and will also be the name of 
the new subline. 

SR SoftRater. The engine that executes the rating, rules and underwriting 
instructions defined within RateManager. The rating environment for 
runtime execution and processing of business content. SoftRater can 
be further defined by the operating system where it has been loaded.  

SRP SoftRater Packages. A package that holds all the RateManager logic 
for a specific program and version.  

SR-JAVA SoftRater for Java. This is also another name for IBSS.  
SR-WIN – SoftRater for Windows. This is also another name for IBFA.  
String: A data type supported for all types of variables and inputs. Examples 

of string values are "2.718", "The quick brown fox jumps over the lazy 
dog." and "001". 

Subline: Sublines are classifications that fall in between lines of business and 
program folders. Sublines allow for the separation of programs by 
source. 
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T 
Tab-delimited: A type of text file in which columns are separated by tabs. This is the 

required format for importing tables into RateManager. 
Template: Templates are exact copies of existing programs within a line of 

business that can be from within your own user group, any other user 
group within the company or even from an outside company.  

U 
Unassigned Driver: A driver who has not been assigned to a vehicle.  
Unassigned Vehicle: A vehicle that has not been assigned a driver. 
Underwriting 
Algorithm: 

A type of algorithm used to determine if a policy meets the 
requirements of the company. 

Universal: A collection of programs from all lines of business combined with result 
group mappings and assigned to execute in sequence that returns a 
single or multiple results. 

V 
Variable: A name used to represent a value that can change. See Variables in 

the Contents section for more information. 
Version: One of a sequence of copies of a program, each incorporating new 

modifications. See Versioning in the Contents section for more 
information. 

VFS Virtual File Servers. Virtual file server management allows you to set 
up servers that are in different locations where packages can be 
downloaded. 

W 
Wildcard: An option available for mapped variables that tells RateManager that 

one or more rows ignore the value passed in for the criteria. See 
Variables in the Contents section for more information. 

Workflow: A workflow is a type of program that allows you to call multiple 
programs from different lines of business together under one universal 
program. 

Working Category: A classification used to define how elements should run. See 
Categories in the Contents section for more information. 

X 
XML ID: A number automatically assigned by RateManager to identify inputs 

and categories. 
 
 
 



Index 

Index 

INDEX 

A 
Accessing 

Line of Business, 14 
Actions 

Import Wizard, 37 
Activated 

Line of Business Listing Screen, 16 
Activating 

Line of Business Listing Screen, 20 
Adding 

Group, 53 
New User in User Management, 46, 52 

Admininstration 
Allow Data Type Change, 79 
Backup Share Folder Location, 78 
Batch Package Threads, 78 
Batch Results with New Line, 79 
Change Control, 80 
Default Proxy Script Location, 80 
Enforce Release Packaging, 78 
Inactive Session Time Out, 79 
Maximum Amount of Simultaneously Opened Tabs, 

80 
Messaging Server, 78 
Minimum Login User ID Length, 79 
My Recent Snap List, 79 
Online Help, 79 
Show Override Date Mask, 79 
SoftRater Server, 78 
Use Insbridge Com + Admin, 78 
User Must Change Password, 79 

Administration Section, 76 
Online Help Settings, 79 
Setting Options, 77 

Administrator 
Group Management, 51 
User Management, 45 

Administrator Group, 51 
Security Access, 51 

Allow Data Type Change 
Admin, 79 

Assigning 
Group Rights, 57 

Audit Listing, 23, 31, 45 
Audit Logs, 22 

Filter, 23, 25, 46, 52, 62, 65, 70 
Filtering, 25 
Purging, 28 
Viewing, 23, 31, 45, 61 

Audit Report, 27 

Creating, 27 
Details, 28 

Audit Reports 
Change Control, 26 

Auditing 
Groups, 54 

Authoring Environment Definition, 83 

B 
Backup 

Deleting, 68 
Restoring, 67 
Storing, 66 
Success Message, 66 

Backup Share Folder Location 
Admin, 78 

Batch Package Threads 
Admin, 78 

Batch Results with New Line 
Admin, 79 

C 
Change Control 

Admin, 80 
Audit Reports, 26 

Change Password, 75 
Change Password Window, 75 
Changing 

Administrator Email, 78 
Company 

Selecting for New User, 47 
Completion 

Import Wizard, 41 
Configure ProgramImport 

Import Wizard, 35 
Create Backup Window, 66 
Creating 

Audit Report, 27 
Backups of Database, 64 
Database Snapshot, 65 

Custom 
Audit Logs, 25 

Custom Type 
Line of Business Listing Screen, 16 

D 
DataBase 

Navigating in Tools, 65, 70 
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Tools, 64 
Database Snapshot 

Creating, 65 
Database Updates 

Running, 70 
Viewing, 70 

Deactivating 
License, 62 
Line of Business Listing Screen, 20 

Default 
Groups, 51 
Sublines, 33 

Default Proxy Script Location 
Admin, 80 

Delete 
Releases 

Delete, 31 
Delete Auditt, 24 
Delete Backup, 68 
Deleting 

Database Backup, 68 
Errors for a Group Delete, 59 
Group, 59 
Line of Business, 16 
Programs From Tools, 42 
User in User Management, 50 

Deploy 
Releases, 23, 31, 46, 52, 53 

Description 
Line of Business Listing Screen, 16 

Details 
Audit Report, 28 

Download to File, 44 
Downloading 

Files From Tools, 44 

E 
Edit 

Line of Business Listing Screen, 15 
Edit Group Screen, 58 
Edit Release Options 

Releases, 23, 46, 52, 53, 62 
Edit User 

User Management, 48, 49 
Editing 

Group, 57 
Line of Business Listing Screen, 19 
User in User Management, 48 
Web Config Settings, 76 

Editing Group Rights 
Example, 57 

Edition Notice, 2 
Email 

Changing Administrator, 78 
Enforce Release Packaging 

Admin, 78 
Errors 

Creating Backups, 66 
Deleting a Group, 59 

Example 
Editing Group Rights, 57 

Execute Update Script, 71 

F 
False 

New Users, 48 
Filter 

Audit Logs, 23, 25, 46, 52, 62, 65, 70 
Filtering 

Audit Logs, 25 
Framework Administrator 

Administrator Email, 78 
Full Access, 10 

Group Rights, 57 

G 
Get Summary 

Import on Tools, 36 
Global Imports 

Importing in Tools, 41 
Globals 

Values in Sublines, 33 
Group 

Administrator, 51 
Default, 51 
Full Access Rights, 57 
Name when Adding, 53 
Rights Assigned to Users, 51 
Security, 45 
Selecting for New User, 47 
Settings for Audit Logs, 54 

Group Management, 52 
Adding a Group, 53 
Auditing, 54 
Deleting a Group, 59 
Editing a Group, 57 
Menu Bar, 52 
Overview, 51 

Groups 
Assigning Rights, 57 

H 
High 

Auditing, 54 
Home Tab, 13 

I 
IBFA Definition, 84 
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IBRU Definition, 84 
IBSS Definition, 84 
ID 

Line of Business Listing Screen, 16 
Import 

Deleting Programs from Tools, 42 
Downloading Files from Tools, 44 
Uploading Files from Tools, 42 

Import Programs 
Right Click Menu, 32 

Import Wizard, 33 
Screen1, 34 
Screen11, 40 
Screen12, 41 
Screen2, 35 
Screen3, 36 
Screen4, 37 
Screen5-9, 38 
Valid Actions, 37 
Valid Statuses, 37 

Importing 
Import Wizard, 38 
Rules for Global Imports, 41 

Imports 
Tools, 30 

Inactive Session Time Out 
Admin, 79 

L 
License 

Deactivating, 62 
Line of Business 

Accessing, 14 
Activating Users, 17 
Deleting, 16 
Navigating To, 14 
Navigation Bar, 15 
Overview, 14 
Setting Security, 18 

Line of Business Listing Screen 
Activated, 16 
Activating, 20 
Custom Type, 16 
Deactivating, 20 
Description, 16 
Edit, 15 
Editing, 19 
ID, 16 
Naming Convention, 17 
New, 15 
Removing All Programs, 21 
System Type, 16 
Type, 16 

Listing Screen 
Line of Business, 16 

LOB Listing Screen, 16 
Logical Environment Definition, 85 

Login, 9 
Failure, 9 
Help, 10 

Logs 
Audit, 22 
Filter, 23, 25, 46, 52, 62, 65, 70 

M 
Maint 

Creating Backups, 66 
Mandatory Database Updates, 74 
Maximum Amount of Simultaneously Opened Tabs 

Admin, 80 
Menu Bar 

Group Management, 52 
Releases, 23, 31, 46, 61, 65, 69 

Messaging Server 
Admin, 78 

Minimum Login User ID Length 
Admin, 79 

My Recent Snap List 
Admin, 79 

N 
Name 

Group Name Rules, 53 
Naming Convention 

Line of Business Listing Screen, 17 
Navigating 

DataBase in Tools, 65, 70 
Security Section RateManager, 45 
Session Management, 62 
To Line of Business, 14 
User Management, 45 

Navigation Bar 
Lines of Business, 15 

Network User 
Selecting for New User, 48 

New 
Line of Business Listing Screen, 15 
Releases, 23 

New User in User Management 
Adding, 46, 52 

No Access, 10 
None 

Auditing, 54 
Normal 

Auditing, 54 

O 
OBI Publisher, 28 
Online Help 

Admin, 79 
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Online Help settings 
Administration Section, 79 

Open Update Script, 73 
Overview 

Group Management, 51 
Line Of Business Screen, 14 
Session Management, 61 
Threading, 78 
User Management, 45 

P 
Package Location Definition, 85 
Password 

Changing, 75 
Default, 46 
Reset, 49 

Password Expires 
Web Config File, 48 

Permissions, 10 
Physical Environment Definition, 85 
Processing 

Import Wizard, 40 
Purging 

Audit Logs, 28 

R 
RateManager 

Security, 45 
Rating Environment Definition, 86 
Read Only, 10 
Refresh 

Releases, 23, 31, 46, 52, 53, 62, 65, 70 
Releases 

Delete, 31 
Deploy, 23, 31, 46, 52, 53 
Edit Release Options, 23, 46, 52, 53, 62 
Menu Bar, 23, 31, 46, 61, 65, 69 
New, 23 
Refresh, 23, 31, 46, 52, 53, 62, 65, 70 

Removing All Programs 
Line of Business Listing Screen, 21 

Reset Password, 49 
Resolving Categories 

Import Wizard, 37 
Restore Backup, 67 
Restoring 

Database Backup, 67 
Right Click Menu 

Import Programs, 32 
Rights 

Assigned by Groups, 51 
Assigning to Groups, 57 
Full Access, 57 
Security, 45 

Rights Management Window, 56 
rm 

Backups to Oracle Insurance, 66 
Creating Backups, 66 

RM Definition, 86 
Rules 

Username, 47 
Running 

Database Updates, 70 

S 
Script 

Executing Update, 71 
Viewing Update, 73 

Security 
Access by Administrator Group, 51 
Creating Backups, 66 
RateManager, 45 

Security Section 
Navigating, 45 

Session Management 
Navigating, 62 
Overview, 61 

Session Management Tab, 62 
Setting 

Security for Line of Business, 18 
Setting Options 

Administration Section, 77 
Settings, 76 

Administration, 76 
Editing Web Config, 76 
Thread, 78 

Show Override Date Mask 
Admin, 79 

SoftRater Node Definition, 86 
SoftRater Packages 

Environments, 85 
SoftRater Server 

Admin, 78 
SR Definition, 86 
SR-JAVA Definition, 86 
SRP Definition, 86 
SR-WIN Definition, 86 
Statuses 

Import Wizard, 37 
Storing 

Backup, 66 
Sublines, 33 
Sync Menu 

Creating New Line of Business, 17 
System Type 

Line of Business Listing Screen, 16 
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T 
Template 

Sublines, 33 
Thread 

Settings, 78 
Threading 

Overview, 78 
Tools 

DataBase, 64 
Deleting Programs, 42 
Downloading Files, 44 
Imports, 30 
Navigating to DataBase, 65, 70 
Security, 52 
Uploading Files, 42 
Versions, 81 

True 
New Users, 48 

Type 
Line of Business Listing Screen, 16 

U 
Update 

Password, 75 
Web Config Settings, 77 

Uploading 
Files From Tools, 42 

Use Insbridge Com + Admin 
Admin, 78 

User 
Adding to Line of Business, 17 
Audit Logs, 22 
Deleting, 50 
Editing, 48 
Group Rights, 51 
Resetting Password, 49 

Selecting Company for New, 47 
Selecting Group for New, 47 
Selecting Network User for New, 48 
Selecting Username for New, 47 

User Authentication, 48 
User Management 

Group Management, 51 
Navigating, 45 
Overview, 45 

User Must Change Password 
Admin, 79 

Username 
Rules, 47 
Security, 45 
Selecting for New User, 47 

V 
Verify Information 

Import Wizard, 36 
Version Information, 81 
Version Listing Window, 81 
VFS Definition, 87 
View Audit Report, 24 
Viewing 

Audit Logs, 23, 31, 45, 61 
Database Updates, 70 
Versions in Admin, 81 

Virtual File Server Definition, 87 

W 
Web Config 

Editing Settings, 76 
Web Config File 

Password Expires, 48 
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